Jam and Practice Tool for Guitar

Owner’s manual
# Table of contents

## Quick Start .................................................. 1
- Step 1 Listen to the sound of the guitar programs ...... 1
- Step 2 Play back a song and cancel the guitar part ... 2
- Step 3 Perform along with the song .......................... 3
  - Importing the guitar karaoke track CD ......................... 3

## Basic operation ......................................... 4
- Knobs ............................................................... 4
- Faders and sliders ............................................. 4
- Switches and buttons ......................................... 5
- ▲ / ▼ (Inc/Dec) buttons ..................................... 5
- Popup menus .................................................... 5
- Items in the screen ......................................... 6

## Performing ................................................ 8

### Selecting a guitar program ................................. 8
- Using the program select buttons to select a program ... 8
- Using the popup menu to select a program ................. 8
- Using the library to select a program ........................ 8
- Downloading guitar programs from JamVOX-Online .... 9
- Use the Audition function to hear a guitar program without having to play your guitar .......... 9

### Performing with your guitar ............................. 10
- Tuning your guitar — TUNER ................................. 10
- Changing the character of your guitar — PICKUP SELECTOR ..................................................... 10
- Adjusting the volume and panning of the entire program — MIXER .................................................. 11
- Using the metronome — METRONOME ..................... 11
- Connecting a mic .............................................. 12
# Table of contents

**Creating your own sounds ....................... 13**

- **How to create your own sounds .................. 13**
  - How a guitar program is structured ................ 13
  - Creating a sound by editing a preset program ..... 13
  - Creating a new sound ................................ 13
  - Comparing an edited program with the original program — Compare function .................. 15
  - Temporarily saving the current settings — Snapshot .... 15

- **Saving a guitar program ......................... 16**
  - Save (overwrite) .................................... 16
  - Save As ............................................ 16

- **Uploading guitar programs to JamVOX-Online 16**

**Library / List ........................................ 17**

- **Items in the screen ................................. 17**
  - Library ................................................ 17
  - Main list ............................................ 17

- **Adding data ....................................... 18**
  - Adding a song from the menu .................... 18
  - Adding a song by dragging and dropping ........ 18
  - Importing a song from a CD ..................... 18
  - Importing songs from the iTunes library .......... 19
  - Importing ToneLab LE programs .................. 19

- **Taking advantage of libraries and lists ........ 19**
  - Searching for data ................................ 19
  - Editing information ................................ 20
  - Choosing the columns shown in the main list ... 20
  - Sorting the data in the list ...................... 21
Music player ........................................... 22

Playing a song ................................................ 22
  Selecting and playing a song you’ve added to the library ........................................... 22
  Rewinding or fast-forwarding the song ................................................ 22
  Adjusting the song’s volume ................................................ 23
  Adjusting the song’s pitch ................................................ 23
  Adjusting the song’s tempo ................................................ 23
  Playing back one or more songs repeatedly ................................................ 23
  Playing a looped region in a song ................................................ 23
  Switching guitar programs while the song plays — Auto Change function ..................... 24

Recording ........................................................... 26

GXT (Guitar XTracktion) function .......... 27

GXT parameters ................................................... 27
  Music player ................................................... 27
  GXT edit panel ................................................... 27

Making GXT settings ........................................... 28
  Canceling a guitar part ........................................... 28
  Extracting/emphasizing the guitar part ........................................... 29

Saving a GXT program ........................................... 30
  Save (overwrite) ........................................... 30
  Save As ................................................... 30

Downloading GXT programs from JamVOX-Online ........................................... 30

Uploading GXT programs to JamVOX-Online ........................................... 31

Option pedal/switch settings ................. 32

Using a pedal for control ......................... 32
  Expression pedal settings ........................................... 32
  Foot switch settings ........................................... 33
Preference settings ............................................. 35

  General .................................................................................................................. 35
    Startup .................................................................................................................. 35
    Basic operations .................................................................................................. 35
    View ...................................................................................................................... 35

  Guitar Programs ................................................................................................. 36
    Snapshot Function ................................................................................................ 36

  GXT .......................................................................................................................... 36

  Player ...................................................................................................................... 36
    Pitch Change Function ........................................................................................ 36
    Tempo Change Function ...................................................................................... 36

  Recording .............................................................................................................. 36

  Hardware ............................................................................................................... 37

  JamVOX-Online ..................................................................................................... 37
    JamVOX Account .................................................................................................. 37
Quick Start

In this section we’ll explain the basics of using JamVOX by taking you through the actual steps of operation.

**Step 1 Listen to the sound of the guitar programs**

1. Click the Program Select buttons (△ / ▽) located at the right of the Guitar program name. Clicking these buttons will move up or down through the programs one by one. Play your guitar to try out each program.

   **HINT:** You can also use other ways to select programs. (☞ “Selecting a guitar program” on page 8)

2. Click the Amp/Cabinet name displayed above the Effect routing section.

   In the Amp/Cabinet combination catalog that appears, you can change the amp/cabinet.

   **HINT:** You can also change the effect units in the same way.

3. Try dragging and dropping an effect device to the location where you want to connect it.

   You are free to change the connected order of all of the effect units.

   **HINT:** The amp/cabinet and effect units can be adjusted in their corresponding control panel. The Effect control panel is shown for the effect device you select by clicking.
Step 2 Play back a song and cancel the guitar part

1. Add song data from your computer to the library by dragging and dropping it into the Main list.

⚠️ The following formats of song data can be added to the library and played: WAV (.wav/.wave), AIFF (.aif/.aiff), MP3 (.mp3), Windows Media Audio (.wma, supported only in Windows), and AAC (m4a, supported only if QuickTime 7 is installed). Song data protected by DRM (Digital Rights Management) cannot be played.

2. Double-click the name of a song you added.
   The song will play.

HINT: To adjust the volume, use the fader located in the right side of the Mixer.

3. Drag the Progress bar pointer to find the guitar solo within the song, and play it back.

4. Click the GXT button.
   The guitar solo will be removed from the playback.

HINT: The effectiveness of the cancellation will depend on how the guitar solo is mixed. In the GXT edit panel, try adjusting the cancellation effect by dragging the pointer and the gray area.

HINT: You can use the Extract button of the GXT edit panel to isolate and emphasize the guitar solo in the playback. Using this in conjunction with the Tempo change function (which lets you slow down the playback speed without affecting the pitch) can be helpful when you’re practicing.
Quick Start

Step 3 Perform along with the song
Now you can simply play your guitar along with the song!
To record your performance (along with the song), just click the Record button.

HINT: Use the fader located in the right side of the Mixer to adjust the volume of the song, and the LOUDNESS knob to adjust the high/low boost. Use the left fader to adjust the guitar’s volume, and the PAN knob to adjust its stereo position.

⚠️ Depending on the song that’s playing, raising the LOUDNESS knob may cause distortion. If so, lower the fader.

HINT: By using the Pitch change function which changes the pitch without affecting the playback speed, you can match the song to the tuning of your guitar. This is also convenient if your guitar is tuned in regular tuning and you’re playing along with a song that is detuned.

JamVOX has many other convenient functions such as Loop or Chain playback of songs, automatic changing of guitar programs, and downloading/uploading of various programs.
Please read the Owner’s manual to learn how you can take full advantage of JamVOX’s potential!

Importing the guitar karaoke track CD
Here’s how to import the bundled guitar karaoke track CD into the JamVOX software.

1 Insert the music CD into your computer.

⚠️ Normally, Windows will display a dialog box asking you to choose an action, and Mac will start up iTunes. We will not use these in this example, so simply close the dialog box or iTunes.

2 From the File menu, choose “Import CD...”.

The Import CD dialog box will appear. This dialog box will show the titles and artist names for the songs on the CD.

⚠️ The song titles and artist names will be shown only for this bundled CD. If you’re importing another CD, you’ll need to enter the song title and artist name into the JamVOX software after importing.

3 If there are any tracks you don’t want to import, click them to clear their check boxes.

NOTE: If you want to change the audio format in which the tracks will be imported, change the setting in the Preferences dialog box.

4 In the lower right of the dialog box, click the “Import” button.

Wait until importing has been completed.

⚠️ The JamVOX software won’t be able to import the CD if you’re using a Windows computer whose CD/DVD drive is an external drive. You’ll need to use other software that is able to import a CD from an external drive, and then add the resulting audio files into the JamVOX software.
Basic operation

You can operate JamVOX’s controllers and parameters using your computer’s mouse and keyboard as follows.

**Knobs**

**Drag**
Drag to adjust the value of the knob. The method of dragging will depend on the “Knob Operation Method” setting in the “Preferences...” of the Option menu. By default, you’ll drag in a straight line to adjust a value.

**Mouse wheel**
You can place the cursor on a knob or fader and use the mouse wheel to adjust the value.

**Drag while holding down your computer’s [Shift] key**
This lets you make fine adjustments to the knob’s value.

**Double-click**
Double-click to reset a knob to its default setting.

**NOTE:** “Default setting” means the value or setting that was set at the factory.

**Faders and sliders**

**Click a fader or slider**
Click the control to set its value to the location at which you clicked.

**Drag a fader or slider up/down or left/right**
Drag the control to adjust its value.

**Mouse wheel**
You can place the cursor on a knob or fader and use the mouse wheel to adjust the value.

**Drag a fader or slider up/down or left/right while holding down your computer’s [Shift] key**
This lets you make fine adjustments to the value.

**Click the value**
You can click a value and enter a numerical value from your computer keyboard.

**Double-click**
Double-clicking will reset the fader or slider to its default setting.

**Use your computer’s keyboard to adjust the value**
Click the knob to select it, and use your computer’s up/down/left/right cursor keys to adjust the value. Use the up/down keys to make coarse adjustments, and the left/right keys to make fine adjustments. When there is a horizontal row of multiple knobs shown in the panel, you can use your computer’s [Tab] key to move to the knob located at the right of the currently-operated knob. Press [Shift]-[Tab] to move back to the knob located at the left.
Use your computer’s keyboard to adjust the value
Click the fader or slider to select it, and use your computer’s up/down/ left/right cursor keys to adjust the value. Use the up/down keys to make coarse adjustments, and the left/right keys to make fine adjustments.
When there is a horizontal row of multiple faders or sliders shown in the panel, you can use your computer’s [Tab] key to move to the fader/slider located at the right of the currently-operated knob. Press [Shift]-[Tab] to move back to the fader/slider located at the left.
Drag a fader or slider up/down or left/right while holding down your computer’s [Alt] key (Mac: Shift+Option key)
This will adjust the value according to the speed at which you move the mouse. As when using [Shift]+drag, fine adjustments can be made using only mouse operations. If you want to make large changes to the value, move your mouse at the normal speed to set the approximate value. Then move the mouse slowly to make fine adjustments.
NOTE: This function is available only for faders and sliders that have a wide value of values and a narrow space in which to drag.

Switches and buttons

Click
Click a switch or button to change the setting each time you click it.

▲ / ▼ (Inc/Dec) buttons

Click
The value will increase or decrease each time you click the button.
Press
Press a button to continuously increase or decrease the value.

Popup menus

Click ▼
Then select the desired setting from the menu that appears.
Items in the screen

1. VOX
2. Play Yer Guitar!
3. VOX AC30TB / VOX AC15
4. PICKUP SELECTOR
5. TUNER
6. VOX WAH
7. VOX
8. EFFECT MODE
9. BYPASS
10. MIXER
11. PAN
12. LOUDNESS
13. Recorder
14. Audio Player
1. **VOX logo**
   You can click this to view the About screen, which provides information about the version.

2. **Program select (program name, Δ / Δ buttons)**
   Here you can view and select the program.

3. **Utility buttons**
   This area contains buttons that perform various functions for guitar programs, such as the Save button, Compare button, and Audition button.

4. **Tube (Valve)**
   This area displays vacuum tubes. The type and number of vacuum tubes shown will depend on the amp model you've selected. The way in which the vacuum tubes illuminate will depend on the “VR GAIN” setting of the amp model.

5. **PICKUP SELECTOR**
   This simulates the guitar’s pickup.

6. **Effect routing**
   The effect routing shows the amp model and how the various effect modules are arranged.

7. **Amp/cabinet control panel**
   Here you can select and adjust the amp model, and select the cabinet model.

8. **Effect control panel**
   This shows the effect module that’s selected in the effect routing area. You can edit the parameters of the effect module that’s displayed.

9. **METRONOME**
   Here you can turn the metronome on/off, and specify its tempo and time signature.

10. **MIXER**
    Here you can adjust the volume of the guitar, mic, and music player tracks.

11. **Music player**
    Here you can play back or record songs.

12. **Library/list**
    This area lets you manage music, guitar programs, and GXT programs.

13. **Function buttons**
    This area contains buttons for various functions used with the music player.

14. **CPU meter**
    This indicates the current load on your computer. If the percentage exceeds 80%, try the following steps.
    • If other applications are running, close them.
    • In the Options menu “Preferences” - “Hardware,” change the “Response setting” toward the “Slow” side. However if this is too slow, there will be more of a delay from when you play your guitar until sound is actually produced.
Performing

Selecting a guitar program
JamVOX contains one hundred programs or more. Here’s how to select programs.

Using the program select buttons to select a program
You can use the program select buttons to step through programs one by one.
Click one of the program select buttons located at the right of the program name.
The ▼ button selects the next program, and the ▲ program selects the preceding program.

Using the popup menu to select a program
You can use the popup menu to make a selection while browsing a list of guitar program names.
Click the program name, and choose a program from the menu that appears.

Using the library to select a program
1 In the “Master Library,” click “Guitar programs” to select it.
The guitar programs saved on your computer will be shown in the main list.

2 To select a guitar program shown in the main list, double-click its name.

HINT: You can select programs by using an optional VOX VFS2 foot switch connected to the JamVOX monitor (☞ “Option pedal/switch settings” on page 32).
Performing

Downloading guitar programs from JamVOX-Online

You can create your own guitar programs in JamVOX and upload them to JamVOX-Online, or download and use guitar programs that were created and uploaded by other users.

Here’s how to download guitar programs.

1. In order to use JamVOX-Online, your computer must be connected to the Internet.
2. You’ll need to register as a user in order to audition or download guitar programs. If you haven’t registered as a user, you’ll only be able to search.

1. In the library, click JamVOX-Online to select it. The main list will show popular guitar programs and GXT programs.
2. If the program you want to use is not shown, enter a song title or artist name in the SEARCH field and press your computer’s Return key. The search results are shown in the main list. If you don’t get the results you want, try changing the terms you enter in the SEARCH field.

NOTE: To quickly find guitar programs suitable for a favorite song, click the magnifying glass button located at the right of the “Name” shown in the main list. The “Song title” and “Artist” will automatically be entered in the SEARCH field, allowing you to quickly find the desired guitar program.

3. You can audition a displayed program by double-clicking it. If you haven’t registered as a user, proceed with registration as directed by the dialog box that appears.
4. If you like the program, click the download button that’s shown in the main list, and the program will be saved in “My Downloads.”

Use the Audition function to hear a guitar program without having to play your guitar

The Audition function uses one of the provided audition riff loops (guitar phrases) to audition the sound of the guitar program you’ve selected, so you can hear the program without having to play your guitar.

1. In the group of utility buttons located at the right of the program select area, click the Audition button. An audition riff will play.

2. Click the ▼ located at the right of the Audition button, and choose a phrase from the menu that appears.

3. The audition riff will stop when you click the Audition button again.
Performing with your guitar

Tuning your guitar — TUNER

1. In the effect routing area, click TUNER to select it.

The tuner will appear in the effect control panel.

2. If necessary, click the CALIB buttons (▲/▼) to specify the calibration.

The calibration is the reference frequency used for tuning (expressed as the frequency of the middle A note of a piano, A4). You can adjust this in a range of 410–480 Hz. By default, this is 440 Hz.

3. Play a single note on your guitar, and tune the pitch approximately, so that the desired note name appears in the display.

The display will show the note name that is closest to the pitch you played.

NOTE: If you want to tune without producing sound, click the MUTE button.

4. Use the LED meter to tune your guitar precisely.

Tune the string so that only the center LED is lit. The illumination in the LED meter will move to the right of center if the pitch is sharp, or to the left if the pitch is flat.

Changing the character of your guitar — PICKUP SELECTOR

The pickup selector simulates the characteristics of various guitar pickups, allowing you to modify the pickup tone of your connected guitar.

ON/OFF

Turns the pickup selector on/off. If this is on, the pickup selector will be enabled for all guitar programs.

TYPE

Selects the type of pickup.

- **Hum (Humbucker) > Single:** Transforms the sound of a humbucking pickup to that of a single coil pickup.
- **Single > Hum (Humbucker):** Transforms the sound of a single coil pickup to that of a humbucking pickup.
- **Half Tone:** Produces a “half tone” sound.
- **Phase Out:** Produces the sound of pickups wired out of phase.

TONE

Adjusts the sound of the pickup type selected by “TYPE.” The result will depend on the pickup type.
Performing

Adjusting the volume and panning of the entire program — MIXER
Here you can adjust the volume of the guitar, mic, and music player tracks.

Faders (-infinity – +6 dB)
These faders adjust the output level of the guitar, mic, and music player. The default setting is 0 dB.

Peak indicators
Indicate the peak level of the guitar, mic, and music player volumes.

PAN
Adjusts the panning of the guitar output.

ECHO
Adjusts the echo for the mic output.

LOUDNESS
Boosts the low range and high range of the song being played by the music player.

⚠️ Depending on the song that’s playing, raising the LOUDNESS knob may cause distortion. If so, lower the fader.

Rec buttons
When recording, these buttons specify whether the guitar, mic, and music player tracks will be recorded. If a button is off (unlit), that track will not be recorded (☞ “Recording” on page 26).

Guitar/Mic/Music buttons
These turn the guitar, mic, and music player tracks on/off. If a button is off (unlit), that track will not be output.

Using the metronome — METRONOME
Here you can turn the metronome on/off, and specify its tempo and time signature.

ON/OFF
Turns the metronome on/off.

TEMPO
Adjusts the tempo.

VOLUME
Adjusts the metronome’s volume.

RHYTHM
Specifies the metronome’s note value.

BEATS
Specifies the metronome’s time signature.

SOUND
Specifies the sound of the metronome.
Click: The typical metronome click sound.
Side Stick: A snare drum’s side stick sound.
Cowbell: Cowbell.
Hi-Hat: Hi-hat.
Connecting a mic

1. Connect a dynamic mic to the JamVOX monitor’s MIC IN jack.

   Only dynamic mics can be connected. You can’t connect mics that require a power supply, such as a condenser mic.

2. Make sure that the mixer’s mic track is on (lit blue) and that the mic fader is at the 0 dB position.
   The middle fader of the mixer is the mic fader.

3. Use the JamVOX monitor’s MIC INPUT LEVEL knob to adjust the input level of the mic.
   While you vocalize into your mic, adjust the level as high as possible without allowing the mixer’s peak indicator to light.

4. Use the faders of the mixer to adjust the volume balance of the guitar, song, and mic.
   Play your guitar or the music player while vocalizing into the mic, and make adjustments as desired.
Creating your own sounds

How to create your own sounds
You can create a sound in either of two ways. You can choose an existing preset program that’s close to the sound you want, and then edit the program as necessary. Or, you can create your sound “from scratch,” starting from a “blank” state.

How a guitar program is structured
The effect section of the JamVOX software is broadly divided into effect routing, amp/cabinet control panel, and effect control panel. 
Routing includes the tuner, pedal effect 1, pedal effect 2, amp/cabinet, noise reduction, modulation effect, delay effect, and reverb effect. For items other than the amp/cabinet, you can drag and drop them to freely change the way in which they’re connected, to remove them from or add them into the routing line.
In JamVOX you can use this effect routing area, amp/cabinet control panel, and effect control panel to edit the sound of the amp and effects.

Creating a sound by editing a preset program
If you want to create your sound by editing an existing program, choose a program that’s close to the sound you want, and then edit the amp and effect parameters to create the desired sound. For example, you might start with a modern crunch sound, and raise the gain to create a contemporary lead sound that’s louder with a more emphasized mid-range.

HINT: Even if you exit the JamVOX application during your editing, the edited state of the program can be recovered the next time you start up the application (☞ “Startup” on page 35).

Creating a new sound
Here’s how to create a sound from scratch.
1 Choose Initial Program from the popup menu or from the library.
2 In the amp/cabinet control panel located below the effect routing, use “AMP” to select an amp model.

Click the displayed amp model name to see a catalog, or use the ▲/▼ buttons to select an amp model. The design of the panel will change depending on the amp model you select.
You can also double-click the amp displayed in the effect routing, or click the amp/cabinet name and choose an amp model and recommended cabinet from the catalog that appears.
For details on the types of amp model, refer to “JamVOX Effect guide” (PDF).
If you don’t want to use an amp model, turn the BYPASS switch (located at the left of the amp model name) off so that the indicator is dark.
3 In the amp/cabinet control panel, use “CABINET” to select a cabinet model.
Click the displayed cabinet model name and choose from the catalog, or use the ▲/▼ buttons to select a cabinet model.
For details on the types of cabinet model, refer to “JamVOX Effect guide” (PDF).
If you don’t want to use a cabinet model, turn the BYPASS switch (located at the left of the cabinet model name) off so that the indicator is dark.

4 Use the control knobs in the amp/cabinet control panel to adjust the sound of the amp.
For details on the amp parameters, refer to “JamVOX Effect guide” (PDF).

5 Drag and drop effects in the effect routing section to add them to the routing line. You can also drag and drop effects to change the order in which they are connected.

6 Click an effect that you want to edit.
The panel of the selected effect will appear below the amp/cabinet control panel.

7 In the effect control panel, use “EFFECT MODEL” to select an effect model.

Click a displayed effect model name and choose from the catalog that appears, or use the ▲/▼ buttons to select an effect. The panel design will depend on the effect model that’s selected.
You can also access the catalog by double-clicking an effect that’s shown in the effect routing, or by clicking the effect name.
For details on the types of effect model, refer to “JamVOX Effect guide” (PDF).
If you don’t want to use a selected effect model, turn its BYPASS switch (located at the left of the effect model name) off so that the indicator is dark, or drag and drop it in the effect routing area to remove it from the routing line.

8 Use the control knobs of the effect control panel to edit the effect parameters.
For details on the available parameters, refer to “JamVOX Effect guide” (PDF).

9 You can edit other effect models as described in steps 6 and 7.

Depending on the amp model or effect model settings, the JamVOX monitor’s output may clip. If this occurs, adjust the output level of the amp model or the distortion-type effect model.

10 If you need to adjust the volume, such as when there are volume discrepancies with other guitar programs, adjust the PROG LEVEL that’s located at the upper right of the effect routing.

11 Click the utility Save button or Save As button to save the guitar program (*“Saving a guitar program” on page 16).
Comparing an edited program with the original program — Compare function
Here’s how to compare the sound you’re editing with the original unedited sound.

1. Select an existing program, and edit it.
   When you edit, the program name will change to a slanted typeface.

2. During your editing, click the utility Compare button.
   The guitar program will return to the unedited settings. The program name will also return from the slanted typeface to the original typeface. Each time you click the Compare button, you will alternate between the edited sound and the original sound.

Temporarily saving the current settings — Snapshot
The Snapshot function lets you temporarily save the current settings of the edited guitar program when desired. In the process of creating a guitar sound, you can use this function to save interim results that you can compare as you continue editing.

1. Edit an existing program.

2. While editing, click the utility Snapshot button.
   The screen will light white, and the settings of the guitar program at the moment you clicked the Snapshot button will be temporarily saved.

3. Click the ▼ located at the right of the Snapshot button, and a popup menu will appear.
   This menu contains the guitar program name, and the date and time at which you captured the snapshot.

4. From the menu, choose a guitar program name/date/time.
   The guitar program will change to the settings that you saved at the selected date and time.

HINT: The Preference settings in the Option menu allow you to specify the duration for which the saved snapshot data will be saved, or to erase it (☞ “Snapshot Function” on page 36).
Saving a guitar program
Here’s how to save a guitar program you’ve edited.

⚠️ If you switch to a different program without saving the one you’ve edited, your changes to the edited program will be lost.

Save (overwrite)
If you click the utility Save button, the current settings will be saved by overwriting them onto the program that is saved in the library.

Save As
This will save the program to the library as a new program, separately from the currently-edited program.

1. Click the utility Save As button.
   A dialog box will appear, allowing you to enter information about the program.
2. Enter the information as necessary.
3. Click the OK button.
   The edited settings will be saved as a new program, and added to the library.

Uploading guitar programs to JamVOX-Online
You can create your own guitar programs in JamVOX and upload them to JamVOX-Online, or download and use guitar programs that were created and uploaded by other users.

Here’s how to upload guitar programs.

⚠️ In order to use JamVOX-Online, your computer must be connected to the Internet.
⚠️ You’ll need to register as a user in order to upload guitar programs.

1. Click to select the source list that includes the guitar program you want to upload.
   The guitar program will be shown in the main list.
2. Right-click the guitar program (Mac: Control-click), and choose Upload from the menu that appears.
   Information about the guitar program will be displayed.
   If you haven’t registered as a user, proceed with registration as directed by the dialog box that appears.
3. Note the content, edit it if necessary, and then click OK. The guitar program will be uploaded. If you decide to cancel, click Cancel.

NOTE: To upload the guitar program you’re currently playing, click the utility Upload button that’s located at the right of the program name.
In the library you can edit and manage songs you’ve loaded into JamVOX, guitar programs, GXT program data, and program information.

**Items in the screen**

**Library**
Here you can manage all data used by JamVOX. The various types of data such as songs, guitar programs, and GXT programs are managed in separate “source lists.”

**Master Library**
This manages all of the songs, guitar programs, and GXT programs saved in JamVOX. When you click “Music,” “Guitar programs,” or “GXT programs,” the selected data will appear in the main list.

- **Music**
  This manages all of the songs you’ve loaded into JamVOX.

- **Guitar programs**
  This manages all of JamVOX’s guitar programs; the preset guitar programs as well as the guitar programs you’ve created.

- **GXT programs**
  This manages all of JamVOX’s GXT programs; the GXT program templates as well as the GXT programs you’ve created.

**JamVOX-Online**
Here you can search, audition, and download guitar programs and GXT programs that have been uploaded to JamVOX-Online. If you’ve clicked here to make a selection, popular guitar programs or GXT programs will appear in the main. (“Downloading guitar programs from JamVOX-Online”, “Downloading GXT programs from JamVOX-Online”)

**My Libraries**
This manages your own favorite songs or guitar programs. You can click the button to add a new source list. By default, there will be source lists such as “Guitar Programs,” “GXT Programs,” “Rhythm Patterns,” “My Recordings,” and “My Downloads.”

**Main list**
When you click one of the library source lists “Music,” “Guitar programs,” or “GXT programs” to select it, the main list will show the data that’s being managed by that source list. The main list shows various information about the data. You can edit this information in the information dialog box that appears when you select “Get Info” from the File menu or right-click (Mac: Ctrl-clicking) it and choosing “Get Info.”
Adding data
In order to play back audio data using JamVOX’s music player, you’ll need to add the song to the JamVOX library.

Adding a song from the menu
1. From the File menu, choose “Add to library...”. A dialog box will appear.
2. Select the song that you want to add to the library, and click the [Open] button. Alternatively, double-click the file name of the song that you want to add.
   The song will be added to the library and shown in the main list for Music.

Adding a song by dragging and dropping
1. Drag and drop a song file from your computer directly into the main list.
   Even if the items shown in the main list are not songs, the songs you dragged and dropped will be added to the Music library.

Importing a song from a CD
Songs from a music CD inserted in your computer can be converted to data and added to the library.
The music player can convert the song into the following types of audio data:
- WAV (.wav/.wave)
- AIFF (.aif/.aiff)
- WMA (.wma): Supported only on Windows.
- AAC (m4a): Supported only on Mac.

1. Insert the music CD into your computer.
   ☢ Normally, Windows will display a dialog box asking you to choose an action, and Mac will start up iTunes. We will not use these in this example, so simply close the dialog box or iTunes.
2. From the File menu, choose “Import CD...”.
   The Import CD dialog box will appear. This dialog box will show the titles and artist names for the songs on the CD.
   ☢ The song titles and artist names will be shown only for this bundled CD. If you’re importing another CD, you’ll need to enter the song title and artist name into the JamVOX software after importing.
3. If there are any tracks you don’t want to import, click them to clear their check boxes.
   NOTE: If you want to change the audio format in which the tracks will be imported, change the setting in the Preferences dialog box.
4. In the lower right of the dialog box, click the “Import” button.
   Wait until importing has been completed.
   ☢ The JamVOX software won’t be able to import the CD if you’re using a Windows computer whose CD/DVD drive is an external drive. You’ll need to use other software that is able to import a CD from an external drive, and then add the resulting audio files into the JamVOX software.
Importing songs from the iTunes library
1 From the File menu, choose “Import iTunes library.”
   All songs that have been imported into iTunes will be added to the
   JamVOX library.
NOTE: Depending on the number of songs being imported, this may
   take some time.
   Songs protected by DRM (Digital Rights Management) cannot be
   imported.

Importing ToneLab LE programs
Program data created in VOX ToneLab LE can be added to the guitar pro-
grams of the JamVOX library.
NOTE: The ToneLab LE program data must already be saved on your
   computer. For details, refer to the ToneLab LE Editor Help.
1 From ToneLab LE Editor’s File menu, use “Export...” or “Save As...”
   to save the effect program data (.tllp) on your computer.
2 From the File menu, choose “Import ToneLab LE programs...”
   A dialog box will appear, allowing you to select the file to import.
3 Select a file, and click the [Open] button.
   The ToneLab LE programs will be added to the Guitar Program
   library.

Taking advantage of libraries and lists

Searching for data
You can enter a keyword and search for guitar programs, GXT programs,
or songs within your own computer or on JamVOX-Online.
1 Select the source list that you want to search.
2 Click to select the SEARCH field, and enter the characters you want to
   find.
   Each character you enter will narrow the search and display the results in
   the main list.
3 Double-click to add that song or program to the library.

Using JamVOX-Online
You can search for programs that other users uploaded to JamVOX-Online.
1 In the library area, click JamVOX-Online to select it.
   Popular programs will be shown in the main list.
2 If you don’t see the program you want, enter the song title or artist
   name in the SEARCH field and press your computer’s Return key.
   The search results will appear in the main list. If you don’t get the
   desired results, try entering different items in the SEARCH field.
NOTE: To quickly find programs suitable for a favorite song, click the
   magnifying glass button Q located at the right of the “Name”
   shown in the main list. The “Song title” and “Artist” will auto-
   matically be entered in the SEARCH field, allowing you to
   quickly find the desired program.
Editing information

Editing information in the main list
Here’s how to edit items of the main list within the list itself.
1. In the main list, click the row that contains the item you want to edit.
2. Click the item that you want to edit.
   The item will become editable.
3. Edit the item and press the Return key.

Editing information in a dialog box
You can edit the information for songs, guitar programs, or GXT programs saved in JamVOX. As an example, here’s how to edit the information for a song.
1. Select the Music library, and then select one of the songs in the main list.
2. Right-click the song, and from the menu that appears, choose “Get Info.” (Mac: Control-click)
   The data information dialog box will appear.
   You can also access this dialog box by choose the File menu item “Get Info.”
3. Click the Info tab.
   The song information will be displayed.
4. Edit the song information.
5. When you’ve finished editing, click the OK button to close the dialog box.

Choosing the columns shown in the main list
You can choose the columns of information that will be shown in the list.
Your choices are saved for each library.
1. Right-click the column title area of the main list. (Mac: Control-click)
   The display option list will appear, showing the items that can be shown.
2. Select each item that you want to see, so that a check mark is shown by it.
   Items for which there is a check mark will be shown in the list.
   If you remove a check mark, that item will not be shown in the list.
Sorting the data in the list

You can sort the items in the main list. The sorting criteria are saved for each list.

1. Click a column title in the main list.
   The data in the list will be sorted by the column you clicked. For example if you clicked “Name” in the Music library, the list will be sorted by name.

2. Click the triangle symbol shown at the right of the column title.
   The sorting order will be reversed.

In this way, songs in the library that have the same genre or guitarist etc. can be brought together in the list.

NOTE: If the item by which you want to sort is not shown, right-click the column title to access the option list, and check the item for the column that you want to see. (☞“Choosing the columns shown in the main list” on page 20)
Music player

JamVOX contains a music player. You can use it to play audio data that’s saved on your computer, or to record your guitar or other performances. The music player can play back the following types of audio data.

- WAV (.wav/.wave)
- AIFF (.aif/.aiff)
- MP3 (.mp3)
- WMA (.wma): Supported only in Windows.
- AAC (m4a): Supported if QuickTime 7 is installed.

Songs protected by DRM (Digital Rights Management) cannot be played.

The music player provides the following functions that are ideal for practicing or for learning songs by ear.

- Loop playback within a song.
- Adjustable playback speed and adjustable pitch.
- GXT function that lets you cancel or extract the guitar part from the song that’s playing.
- Auto Change function that lets you assign a marker to a location within a song, causing the effect to switch automatically.
- Record songs and performance.

Playing a song

Selecting and playing a song you’ve added to the library

1. In the source list, click “Library” - “Music.”
   The main list will show the songs that have been added to the library.
2. In the list, click to select the song that you want to play.
3. Click the PLAY/PAUSE button, or double-click the name of a song shown in the main list.
   The selected song will play. During playback, “ ” is shown at the far left of the main list.
   The display will show a progress bar that indicates the playback position and the loop region, and the playback time.
   You can pause the playback by clicking the PLAY/PAUSE button.

Rewinding or fast-forwarding the song

Clicking the button during playback will take you to the beginning of the currently-playing song. If you click this button near the beginning of the song, you’ll return to the beginning of the preceding song.

Clicking the button during playback will take you to the beginning of the next song.

HINT: You can also move the song playback location by clicking the bar that’s shown in the display.
**Adjusting the song’s volume**

Use the fader located in the right of the Mixer section to adjust the volume of the currently-playing song.

**HINT:** In the Mixer section you can adjust the volume balance of the guitar, mic, and song playback.

You can adjust the LOUDNESS knob to boost the low and high frequency ranges of the song playback.

⚠️ Depending on the song that’s playing, raising the LOUDNESS knob may cause distortion. If so, lower the fader.

**Adjusting the song’s pitch**

JamVOX lets you adjust the pitch of the currently-playing song without affecting its tempo.
Use the Pitch knob to adjust the pitch. Moving the knob will turn on the Pitch function (the Pitch button will light).
You can adjust the pitch in a range of -500 cents (-5 semitones) – +500 semitones (+5 semitones).
To return to the original pitch, click the Pitch button to make it go dark.

**Adjusting the song’s tempo**

 JamVOX lets you adjust the tempo of the currently-playing song without affecting its pitch.
Use the Tempo knob to adjust the tempo. Moving the knob will turn on the Tempo adjustment function (the Tempo button will light). You can adjust the tempo in a range of -50% – +150%.
To return to the original tempo, click the Tempo button to make it go dark.

**Playing back one or more songs repeatedly**

 JamVOX lets you play back one or more songs repeatedly.

**To repeatedly play one song**

Below the library, click the repeat button twice to make it indicate .

**To repeatedly play back all songs in the list**

Below the library, click the repeat button once to make it indicate  .

**Playing a looped region in a song**

At the point where you want loop playback to begin, click the button located in the upper right of the display. At the point where you want the loop to end, click the button. The region you specified will play as a loop.
The loop region is indicated by and markers and by a blue bar. You can drag the markers to change the loop region.

**NOTE:** Only one loop region can be specified for each song.

When you specify the loop start point, the loop button below the source list will light, and the repeat button will indicate  .
If you click the loop button to make it go dark, loop playback will turn off. The loop region setting is maintained for each song even if loop playback is turned off.

**HINT:** If you’ve selected Show/Hide Hints in Preferences–Appearance, loop information will be shown when you move the mouse over the marker.
Switching guitar programs while the song plays — Auto Change function

The Auto Change function automatically switches guitar programs or GXT programs while the song plays.

In the main list, click the auto change button to assign a guitar program or GXT program marker at the current playback location. When you assign a marker, a marker icon will appear below the progress bar at the location you clicked.

By clicking the button located at the lower left of the display, you can add an empty marker (a marker that contains no auto change data) at the current playback location. After assigning an empty marker, you can add data later.

At the desired locations in a song, you can assign Auto Change markers containing your favorite guitar programs or GXT programs so that these programs will automatically be selected when the song playback reaches those points. You can assign auto change data for a guitar program and a GXT program in each marker, and up to twenty markers can be assigned in a song. (This does not include the A-B markers of the loop region.)

Assigning a marker

In the main list, click the auto change button to assign a guitar program or GXT program marker at the current playback location. When you assign a marker, a marker icon will appear below the progress bar at the location you clicked.

By clicking the button located at the lower left of the display, you can add an empty marker (a marker that contains no auto change data) at the current playback location. After assigning an empty marker, you can add data later.

Editing a marker

You can add or rewrite auto change data by dragging and dropping a guitar program or GXT program from the main list onto an empty marker or a marker that already contains auto change data.

You can move a marker by dragging it.

You can also right-click (Mac: Control-click) a marker to access a shortcut menu from which you can execute operations such as Selecting, Moving, or Deleting the marker.

HINT: If you’ve selected Show/Hide Hints in Preferences – Appearance, the auto change information will be shown when you move the mouse over the marker.

When you assign a marker, the Auto Change function will turn on, and the Auto Change button located below the library will light. Clicking this to make it go dark will turn off the Auto Change function.
Using the event list to edit markers in detail

An event list will appear when you click the button located in the lower right of the display. Here you can make detailed edits to the auto change data of the markers, and to the loop region settings.

The event list shows auto change data and loop region settings.
You can add or rewrite auto change data by dragging and dropping a guitar program or GXT program from the main list onto a line that shows marker information.
You can also click time data to select it, and then enter a time value directly from your computer keyboard.
By clicking the preview [Preview] button, you can start playback from slightly ahead of the specified point in order to verify the settings.
Recording

JamVOX lets you record your own performance. You can also record your own performance along with a song played by the music player. You can try recording your own performance along with one of the karaoke songs on the included CD, or along with a song whose guitar track you’ve cancelled using the GXT function. In this example, we’ll record your guitar performance along the song playback.

1. In the Mixer section, make sure that you’ve made the following settings.
   - Make sure that the Rec button at left (Guitar) and the Rec button at right (Music) are lit. If not, click to make them light.
   - Make sure that the Guitar button and the Music button located below the Rec buttons are lit. If not, click to make them light.

   **NOTE:** The Rec button and Mic button in the center are for the mic. In this example, we don’t care about the state of these buttons.

2. Click the button located in the upper left of the display to show the recording level meter.

3. Adjust the recording level. Click the button to play back the song, and perform on your guitar.
   - While you watch the level meter, use the mixer’s faders to adjust the level of the guitar and the song. Adjust the level so that the loudest volumes reach the “0” position of the meter.

4. When you’ve finished adjusting the recording level, click the button to stop.

5. Click the button to return to the beginning of the song.

6. Click the button to play the song. When you reach the point at which you want to start recording, click the button. Alternatively, click the progress bar to move to the location at which you want to start recording, click the button to enter record-standby mode (the middle of the button will blink), and then click the button to begin recording.
   - Recording will begin. Play your guitar along with the song playback.

7. When you’ve finished performing, click the button to stop recording.
   - The recorded data will automatically be added to the library, and will be saved in your computer’s My Recordings folder.
   - As the format for the recorded data, you can choose WAV, AIFF, WMA (Windows only), or AAC (Mac only). Use the Preference settings to select the format.
GXT (Guitar XTracktion) function

GXT: Guitar XTracktion is revolutionary technology developed by Korg that lets you cancel or extract/emphasize a desired guitar part from an existing song.

With simple operations you can cancel or extract/emphasize the guitar part from your favorite songs so that you can practice or play along on your guitar. This section explains the various functions of GXT so that you’ll be able to take full advantage of it.

⚠️ GXT works by determining the sound’s “stereo position” (panning) and “frequency band.” This means that it won’t be effective on monaural songs. Furthermore, other sounds in the same stereo position and frequency band will be cancelled as well. Also, the effect may be difficult to notice on some songs depending on how the guitar part has been mixed.

GXT parameters

Music player

**GXT button**
Turns the GXT: Guitar XTracktion effect on/off.

**Edit button**
Shows/hides the GXT edit panel. If the GXT button and Edit button are both off, turning the GXT button on will automatically turn the Edit button on as well. (You can disable this in the Preference settings.)

GXT edit panel

**Reduce button**
Turn this on if you want to cancel the guitar part.

**Extract button**
Turn this on if you want to extract/emphasize the guitar part.

**Graph**
This is a conceptual graph of the area that will be cancelled or extracted/emphasized. The gray area is the area that will be cancelled. By using the mouse to drag the graph, you can adjust the DIRECTION, WIDTH (the □ object), and GAIN.

**TARGET GUITAR FREQ. BANDS sliders**
These specify the frequency band of the guitar part that you want to cancel or extract/emphasize. Use the LO slider at left to specify the lowest frequency of the target sound, and use the HI slider at right to specify the highest frequency.
Making GXT settings

Canceling a guitar part
Here we’ll explain the basic method for using GXT to cancel a guitar part.

1. Play back the song, and listen to determine whether in the song (left side, center, right side, both sides) the guitar part you want to cancel is panned. This will be easier to determine if you use headphones.

2. When you’ve determined where the guitar part to be canceled is located, press the GXT button. The GXT effect will turn on, and the GXT edit panel will appear.

3. From the template list in the left of the GXT edit panel, double-click a template that matches the positioning of the guitar part you want to cancel. The settings of the template will be applied to the GXT edit panel and to the playback audio.

The following ten templates are provided.

01 Solo (Center-Wide) Reduction: Since most guitar solos are panned to the center, this template will probably work well.

02 Solo (Center-Narrow) Reduction: If the guitar solo is not spread very far to the left or right, try using this template, which will have less effect on sounds other than the guitar.

03 Solo (Left) Reduction: This template is for canceling a guitar solo that’s panned toward the left.

04 Solo (Right) Reduction: This template is for canceling a guitar solo that’s panned toward the right.

05 Backing (Left) Reduction: This template is for canceling a backing guitar that’s panned toward the left.

AREA buttons
- Select this if you want to cancel or extract/emphasize a guitar part that’s panned to the left side of the song.
- Select this if you want to cancel or extract/emphasize a guitar part that’s panned to the center of the song.
- Select this if you want to cancel or extract/emphasize a guitar part that’s panned to the left and right sides of the song.
- Select this if you want to cancel or extract/emphasize a guitar part that’s panned to the right side of the song.

DIRECTION slider
This adjusts the panning of the area in which you want to cancel or extract/emphasize a guitar part.

WIDTH slider
This adjusts the width of the area in which you want to cancel or extract/emphasize a guitar part.

GAIN slider
This adjusts the gain of the area in which you want to cancel or extract/emphasize a guitar part.

HINT: It’s convenient to use the arrow keys (↑, ↓, ←, →) of your computer to make detailed adjustments to the graph or sliders.
06 Backing (Left-Hard) Reduction:
This template will be effective if the backing guitar that’s panned toward the left has a heavy sound that includes low frequencies and high overtones.

07 Backing (Right) Reduction:
This template is for canceling a backing guitar that’s panned toward the right.

08 Backing (Right-Hard) Reduction:
This template will be effective if the backing guitar that’s panned toward the right has a heavy sound that includes low frequencies and high overtones.

09 Backing (Left & Right) Reduction:
This template is for canceling a backing guitar that’s panned to both left and right sides.

NOTE: Typically, the sound of the backing guitar is also spread through the center of the stereo field. Since the sound in the center will remain even if you cancel the sound at the left and right sides, the effect will probably not be very dramatic.

10 Vocal (Center) Reduction:
In general, a vocal has a broader frequency range than the sound of a guitar, and will be spread to left and right. If you want to cancel the sound of a vocal, start with this template and then adjust the parameters.

You should be able to hear the result of canceling the guitar part. If you want to obtain the best possible cancellation effect, adjust the TARGET GUITAR FREQ. BANDS, DIRECTION, WIDTH, and GAIN as appropriate for the song.

First, use the graph and sliders to find the most effective settings for DIRECTION, WIDTH, and GAIN while you listen to the cancellation of the guitar part.

Next, use the TARGET GUITAR FREQ. BANDS sliders to specify the frequency range of the guitar part.

It’s best to adjust the TARGET GUITAR FREQ. BANDS settings in the following ways.

LO slider: Press the Extract button, and while auditioning the extracted/emphasized guitar part, lower the frequency until you no longer hear the sound of the bass part. Then press the Reduce button, and raise or lower the frequency to obtain the appropriate cancellation for the low notes of the guitar part.

HI slider: Press the Extract button, and while auditioning the extracted/emphasized guitar part, lower the frequency until you hear as little as possible of the hi-hat and snare attacks. Then press the Reduce button, and gradually raise the frequency so that the guitar part is cancelled as much as possible. Repeat this process to make the appropriate adjustments.

NOTE: When adjusting the GXT parameters, minimizing the effect on the drum sounds is an important part of obtaining the most natural-sounding cancellation.

For example if you’ve set the WIDTH fairly wide, set the HI slider as low as possible so that the hi-hat is excluded from the cancellation effect.
Conversely if you’ve set the WIDTH quite narrow, hi-hat sound will remain outside the grey area, so you’ll be able to raise the HI slider.

Extracting/emphasizing the guitar part
After you’ve made the settings described above, you can press the Extract button to extract/emphasize the corresponding guitar part.
If you’re learning a phrase by ear, and would like to obtain the best possible extraction/emphasis effect, adjust TARGET GUITAR FREQ. BANDS, DIRECTION, WIDTH, and GAIN as described in “Canceling a guitar part.”

HINT: If you’re copying or practicing a phrase, it’s especially useful to use this in conjunction with the Tempo Change function that lets you slow down the tempo without affecting the pitch.
Saving a GXT program

Here’s how to save a GXT program you’ve edited.

⚠️ If you switch to a different program without saving the one you’ve edited, your changes to the edited program will be lost.

Save (overwrite)
If you click the Save button in the GXT edit panel, the current settings will be saved by overwriting them onto the program that is saved in the library.

Save As
This will save the program to the library as a new program, separately from the currently-edited program.

1. Click the Save As button in the GXT edit panel.
   A dialog box will appear, allowing you to enter information about the program.
2. Enter the information as necessary.
3. Click the OK button.
   The edited settings will be saved as a new program, and added to the library.

Downloading GXT programs from JamVOX-Online

You can create your own GXT programs in JamVOX and upload them to JamVOX-Online, or download and use GXT programs that were created and uploaded by other users.

Here’s how to download GXT programs.

⚠️ In order to use JamVOX-Online, your computer must be connected to the Internet.

⚠️ You’ll need to register as a user in order to audition or download GXT programs. If you haven’t registered as a user, you’ll only be able to search.

1. In the library, click JamVOX-Online to select it.
   The main list will show popular guitar programs and GXT programs.
2. If the program you want to use is not shown, enter a song title or artist name in the SEARCH field and press your computer’s Return key.
   The search results are shown in the main list. If you don’t get the results you want, try changing the terms you enter in the SEARCH field.

NOTE: To quickly find GXT programs suitable for a favorite song, click the magnifying glass button located at the right of the “Name” shown in the main list. The “Song title” and “Artist” will automatically be entered in the SEARCH field, allowing you to quickly find the desired GXT program.

3. You can audition a displayed program by double-clicking it.
   If you haven’t registered as a user, proceed with registration as directed by the dialog box that appears.
4. If you like the program, click the download button that’s shown in the main list, and the program will be saved in “My Downloads.”
Uploading GXT programs to JamVOX-Online

You can create your own GXT programs in JamVOX and upload them to JamVOX-Online, or download and use GXT programs that were created and uploaded by other users.

Here’s how to upload GXT programs.

⚠️ In order to use JamVOX-Online, your computer must be connected to the Internet.

⚠️ You’ll need to register as a user in order to upload GXT programs.

1. Click to select the source list that includes the GXT program you want to upload.
   The GXT program will be shown in the main list.

2. Right-click the GXT program (Mac: Control-click), and choose Upload from the menu that appears.
   Information about the GXT program will be displayed.
   If you haven’t registered as a user, proceed with registration as directed by the dialog box that appears.

3. Note the content, edit it if necessary, and then click OK. The GXT program will be uploaded. If you decide to cancel, click Cancel.
Option pedal/switch settings

Using a pedal for control
JamVOX lets you use an optional pedal or foot switch connected to the JamVOX monitor to control a variety of functions.

Expression pedal settings
For each program, you can individually specify the effect that will be controlled by an optional Korg EXP-2 controller connected to the JamVOX monitor, and how it will be controlled.

HINT: Assigning a parameter to the expression pedal and operating it in this way is the same as using the pedal instead of the knob to edit the sound. When you use SAVE or SAVE As to save the program, it will be saved with the sound specified by the pedal position at that moment. However, if the expression target is “OFF,” Modulation “PITCH,” Delay “INPUT” (controls the input level to the delay), or Reverb “INPUT” (controls the input level to the reverb), the pedal will not be editing the parameter of the guitar program. Also, the delay effect and reverb effect do not have an “INPUT” parameter.

Assigning a parameter to the expression pedal
Here’s how to assign an effect parameter to the expression pedal.
As an example, we’ll assign the “PITCH” parameter of the PITCH SHIFTER modulation effect to be controlled by the pedal.

1. Choose PITCH SHIFTER as the modulation effect.
2. Press the utility Pedal button.

The FOOT SWITCH and EXPRESSION PEDAL edit screens will appear.

3. From the menu that appears when you click EXPRESSION PEDAL “TARGET,” choose PITCH SHIFTER - PITCH.
4. Specify the expression pedal’s Max value (the value when the pedal is fully advanced) and Min value (the value when the pedal is fully returned).
   
   You can check the result by dragging in the edit screen.

   NOTE: The “MIN” and “MAX” values will be initialized if you change the “TARGET” of EXPRESSION PEDAL.

5. Click the Pedal button to close the edit screen.

   If you want to save your settings, click the SAVE button or SAVE As button. If you switch to a different program or close JamVOX without saving, the settings you made will be lost.

   In addition to the example described above, a large number of effect parameters specified for each effect model can be freely assigned to the expression pedal.

   NOTE: When you change the effect model of the parameter that is assigned to expression, the “TARGET” parameter will be initialized, and will be OFF. (However, the Amp “GAIN” or “VR GAIN,” the Delay “INPUT,” and the Reverb “INPUT” are exceptions.)

HINT: If you selected VOX WAH as the effect model for pedal effect 1 or 2, the expression pedal function will automatically be assigned to MANUAL (the wah pedal position). In this case, changing the pedal effect to another model without performing any other operation will also return the “TARGET,” “MIN,” and “MAX” settings to their previous state. (However, if the pedal effect (PEDAL FX) function is assigned, it will be initialized “OFF” without returning to its previous state.)
Adjusting the sensitivity of the pedal
If you notice that advancing the expression pedal does not reach the full effect or volume even when the Min and Max parameters are set to the minimum and maximum settings, or that returning the expression pedal does not reach the minimum effect or volume, you will need to perform the following adjustment so that expression pedal will be able to reach its full range of operation.

NOTE: Set the minimum volume of the connected EXP-2 controller to the 0 position.

NOTE: When adjusting the sensitivity, you should use your hand to operate the pedal. Accurate adjustment may not be possible if you use your foot to operate it.

1. Click the Calibration button located below EXPRESSION PEDAL. The calibration setting screen will appear.
2. Proceed as directed in the screen.

Foot switch settings
JamVOX lets you use a VOX VFS-2 foot switch connected to the JamVOX monitor to control a wide variety of parameters.
Here we’ll explain how to assign the program up/down functions to the foot switch, and how to assign the tap tempo function.

Assigning guitar program up/down to the foot switch
1. Press the utility Pedal button.
The FOOT SWITCH and EXPRESSION PEDAL edit screens will appear.
The two switches will be assigned to Program Up and Program Down, respectively.
2. In FOOT SWITCH, click “ASSIGN PROGRAM UP/DOWN” to select it.
The left switch will be program-down, and the right switch will be program-up.
You can verify the operation by clicking the foot switches shown in the edit screen.

NOTE: If you assign Program Up/Down to the foot switch, you won’t be able to assign an effect parameter function to the foot switch.

Assigning the delay effect’s Tap function to the foot switch
You can assign the modulation effect’s “Speed” parameter or the delay effect’s “Time” parameter to the foot switch. When you press the foot switch repeatedly, the speed of the LFO or the delay time of the delay effect will be set to the corresponding interval.
In this example, we’ll assign the “Time” parameter of the delay effect to the foot switch. Before you continue, turn on the delay effect.
1. In the delay effect, select the effect model for which you want to assign a parameter to the foot switch.
2  Press the utility Pedal button. The FOOT SWITCH and EXPRESSION PEDAL edit screens will appear.

3  In FOOT SWITCH, click “ASSIGN BYPASS/EFFECT PARAMETER” to select it.

4  Click the FOOT SWITCH “TARGET” parameter, and choose DELAY TAP (TIME) from the menu that appears.

5  Use “FACTOR” to specify a multiplier for the interval at which you tap.
   According to the setting of the “FACTOR” parameter, the parameter being controlled will be set to 1/6, 1/4, 1/3, 1/2, 2/3, 3/4, 1, 4/3, 3/2, 2, 3, or 4 times the tapped interval.

   NOTE: The maximum interval for tapping is ten seconds.

   NOTE: If “TARGET” is set to anything other than MODULATION TAP or DELAY TAP, “FACTOR” will be unavailable. Also, changing “TARGET” will initialize “FACTOR” to 1.

6  Click the Pedal button or the at the upper right of the edit screen to close the edit screen.
   If you want to save your settings, click the Save button or Save As button. If you switch to a different program or close JamVOX without saving, the settings you made will be lost.
Preference settings

The Preference settings allow you to specify things like the appearance of the JamVOX software or the mode of knob operation as appropriate for your system or your taste.

From the Option menu, choose “Preferences…” to access the Preferences dialog box, click the appropriate tab, and make the desired settings.

**General**

**Startup**

**Automatically load the last-played song**
When the JamVOX software starts, the song that was played last will automatically be loaded.

**Automatically load the last-selected guitar program**
When the JamVOX software starts, the guitar program that was selected last will be automatically loaded.

**Automatically load the last-selected GXT program**
When the JamVOX software starts, the GXT program that was selected last will be automatically loaded.

**Basic Operations**

**Knob Operation Method**
Choose how you want the knobs to operate.
- **Linear**: Operate knobs by dragging them up or down. This is the default setting.
- **Circular**: Operate knobs by dragging them in a circular direction.

**View**

**Warn when deleting an item from the master library**
A warning dialog box will appear when you delete a song, guitar program, or GXT program from a master library list.

**Show hints**
When you place the cursor over a knob or switch, a simple explanation or the value of the parameter will be shown.
Guitar Programs

Snapshot Function
Delete snapshots when closing
The saved snapshots will be deleted when you close the JamVOX software.

Length of time to keep snapshots
This specifies how long snapshots will be kept.

Delete Now
If you click this, the currently saved snapshots will be deleted.

NOTE: Up to one hundred snapshots can be saved. If you attempt to save a snapshot that would exceed this number, the oldest snapshot will be deleted.

GXT

Link the panning of the GXT program and the guitar output
The pan setting of the guitar output in the mixer will be linked to the DIRECTION and AREA parameters of the GXT program. This allows you to layer the sound of your guitar onto the location of the guitar part that you cancelled using the GXT function.

Automatically show GXT edit panel
The edit panel will be displayed when you turn the GXT button on or when you load a GXT program.

Player

Pitch Change Function
Automatically turn on the pitch change function
If the pitch change function is off, operating the Pitch knob will automatically turn on the pitch change function.

Tempo Change Function
Automatically turn on the tempo change function
If the tempo change function is off, operating the Tempo knob will automatically turn on the tempo change function.

Recording

Audio Format
Select the data format in which audio will be recorded: WAV, AIFF, WMA (Windows only), or AAC (Mac only).

Audio Quality
Select the quality in which audio will be recorded. This is valid only if you’ve selected WMA (Windows only) or AAC (Mac only) as the audio format.

NOTE: These settings are also used when you load a music CD.

Maximum Recording Time
Specifies the maximum time for recording.

Include the metronome sound when recording
If the metronome is sounding while you record, its sound will be included in the recording.
Hardware
Response
If you feel that there is a lag from when you play your guitar until sound is produced, try setting this to “Fast.” If you experience clicks or noise in the sound, try setting this to “Slow.”

JamVOX-Online
JamVOX Account
Verify your JamVOX account or log-in to JamVOX-Online.
Log in
Connect to JamVOX-Online. You must have already completed user registration.

User Registration
Create a JamVOX account and register as a user. Proceed with registration in the Web browser that will start up.